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Updates to the Manual 
 

November 19, 2024 

• More detail was added regarding how to add a new or existing Traveler and the 2400 hours 
requirements for a Transfer under the section, For Locals – When to add a new member to their 
Local MTP database. 

• Added an Update from Training Center screenshot under the section, How to confirm if your 
Local member has the correct Local assignment at the Training Center? 
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FAQs 
 

What are the goals of the Bi-directional Synchronization Project? 

The Bi-directional Synchronization Project, implemented in 2021, is focused on sharing a member’s 
common demographic information of their membership profile between the LIUNA Chicago Local 
Unions and the Training Center. 

In the future, the plan is also to synchronize a member’s common demographic information with the 
Laborers’ Pension & Welfare Funds of Chicago and Vicinity and Fox Valley Laborers’ Benefit Funds. 

In addition, one of the other goals of this project is to help the International Union’s effort to assist and 
improve the process and accuracy of collecting, updating, and sharing membership profile information 
for Local Union members in good standing – as stated in the November 28, 2017 letter to all LIUNA Local 
Union Business Managers and Secretary-Treasurers. 

This project also streamlines backend office processes at LIUNA Chicago.  

Examples include ensuring correct eligibility for benefits, improving the communication of those 
benefits, and effectively managing Local Union members for the Training Center, Laborers-Employers 
Cooperation and Education Trust (LECET), Labor-Management Cooperation Committee (LMCC), District 
Council, and Midwest Coalition of Labor (MCL). 

 

How does the Bi-directional Synchronization Project benefit membership? 

From a membership point of view, this project will provide LIUNA Chicago members with online access 
to update their membership profile information via the LIUNA Chicago Membership Portal login page: 
https://mtp.chicagolaborers.org.  

With their Public Directory URL, members will have view-only access to their LIUNA Chicago ID Number, 
International Card Number, Local Number, Local Type, Training Center Type, Member Photo, Paid Thru 
Date, Skills, Completed Classes, Upcoming Classes, Contractor Hours (since 2021), and a digital version 
of their Membership Card. 

 

What are the primary new features of the Bi-directional Synchronization Project in MTP? 

1. Bi-directional synchronization of membership profile information between the Training Center 
and a respective Local’s Membership Tracking Program (MTP) 

2. Real-time Social Security number (SSN) check and Paid Thru Date information when adding a 
new member to a respective Local’s MTP database 

3. Member Change Authorization process and signature form 
4. Email and text message profile notifications  

https://mtp.chicagolaborers.org/
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5. Online access for a member to update their profile information via the LIUNA Chicago 
Membership Portal login page: https://mtp.chicagolaborers.org  

 

How should Locals handle a membership Local assignment dispute? 

A: Use the following District Council guidelines when handling a Local assignment dispute between 
Locals: 

• If there are any instances when a member’s Local assignment is in question 
o The respective Locals should attempt to work out between themselves 

• If the Locals agree that a change is to be made to the member’s assigned Local 
o Inform the District Council of the change and the District Council will direct a change to 

their Contribution Accounting System (CAS) and MTP. 
• If the Locals cannot come to a resolution in the dispute 

o Contact the District Council Business Manager and a determination will be made 

IMPORTANT: In the instances above, only the District Council has authority to make changes to the 
database systems. The Training Center, InCom/MTP support staff, or anyone else has no authority to 
change a member’s Local assignment in the MTP databases. 

 

Who can make Local assignment or Social Security number (SSN) changes in MTP? 

If there is a membership Local assignment discrepancy/dispute or an SSN change/update, only the 
District Council, with proper documentation, has authority to make changes to the LIUNA Chicago MTP 
database. Please contact the District Council with any questions or concerns.  

IMPORTANT: In the instances above, only the District Council has authority to make changes to the 
database systems. The Training Center, InCom/MTP support staff, or anyone else has no authority to 
change a member’s Local assignment or SSN in the MTP databases. 

 

What is the process for a Local to change a Social Security number (SSN) on a member? 

Before a Local can change an SSN for a member (incorrect to correct or a merge) in MTP, you must have 
proper SSN documentation that is shared with District Council and LIUNA International. 

Seven steps must be followed to successfully transfer the membership profile (demographic info, hours 
earned, training class certifications, and Paid Thru Date, etc.) from an incorrect SSN to a correct SSN. 

1. Member submits the following SSN change documentation forms to the Local 
a. Signed Dues Checkoff and Authorization form 
b. Signed District Council Declaration and Agreement of Indemnification form 
c. Signed Laborers’ Pension Fund Affidavit of Social Security Number Change 

https://mtp.chicagolaborers.org/
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d. If needed – Signed Laborers’ Pension Fund Affidavit of Name Change 
2. Local shares copies of the following SSN change documentation to the District Council 

a. Copy of a Local signed letter on local letterhead requesting the SSN change 
b. Copy of a member’s signed Dues Checkoff form 
c. Copy of a member’s signed District Council SSN change declaration form 
d. Copy of a member’s signed Laborers’ Pension Fund Affidavit of Social Security Number 

Change 
e. If needed – Copy of a member’s signed Laborers’ Pension Fund and Affidavit of Name 

Change 
3. District Council updates the Contribution Accounting System (CAS) with the correct SSN 
4. District Council updates MTP with the correct SSN (see page 13) 
5. District Council calls the Local to confirm SSN changes were made 
6. Local updates MTP with the correct SSN (see page 13) while on the phone with District Council 
7. Local informs LIUNA International with an SSN Change form sent by secure message to 

the General Secretary-Treasurer Office Accounting Representative 

PROCESS NOTE: The Employment Authorization Document (EAD) or Lawful Permanent Resident (LPR) 
application process, which is conducted by USCIS, is separate from Social Security and the Funds cannot 
rely solely on the EAD or LPR documents to merge (or correct) work records under different SSN. 
(source: June 15, 2023, Memorandum from District Council’s James P. Connolly, Business Manager) 

MTP NOTE: The District Council must change the SSN first in MTP. If the Local changes the SSN in MTP 
before the District Council does, a new duplicate individual will be created. In addition, the member will 
have a disconnected “Shadow Profile” of their incorrect SSN in MTP. Shadow Profiles must be avoided. 

 

At Health & Welfare, what are the procedures to change a Social Security number (SSN)? 

To begin, the burden of producing the proper SSN change documentation falls upon the member.  

LIUNA Chicago’s Laborers’ Health and Welfare Department and Pension Department (THE FUNDS) 
require specific types of SSN change documentation from the Social Security Administration. 

THE FUNDS will complete the transferring of hours (from the incorrect SSN to the correct SSN) once the 
member provides the following four forms: 

1. Social Security Administration letter showing the new SSN 
2. Copy of new SSN card 
3. Earnings Summary Sheet or L191 Statement** 
4. Signed Health & Welfare Enrollment Card/Sheet 
5. Signed/Updated Health & Welfare Annual Claim Form 
6. Signed and Notarized Health & Welfare SSN Change Affidavit 

** For a member to consolidate their earnings history into the correct SSN, they will need to provide the 
Social Security Administration with all the tax forms and W2s from years of service under the incorrect 
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SSN and request them to be merged under the correct SSN. After the hours have transferred to the 
correct SSN, the member needs to request a printed copy of the Earnings Summary Sheet or L191 
Statement. 

To learn more about how changes in an SSN affect eligibility for benefits, please go to page 12 of the 
Health & Welfare Plan (PDF). 

 

What type of mobile smartphone is needed to scan a Public Directory QR code? 

To scan a QR code, you need a smartphone with a camera and, in some cases, a mobile QR code reader 
app. FYI – iPhones running iOS 11 (or later) and Androids running Android 9 (or later) can scan a QR code 
when the camera is turned ON.  

https://www.chicagolaborersfunds.com/public/files/W_SPD%20Active%20Plan1.pdf
https://www.chicagolaborersfunds.com/public/files/W_SPD%20Active%20Plan1.pdf
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MTP Capabilities 
 

What membership profile information is bi-directional synchronized in MTP? 

1. Title or a pre-suffix to first name  
2. First name  
3. Middle name or initial  
4. Last name 
5. Post suffix to last name  
6. Address (Primary) – Street/City/State/Zip + Extension 
7. Alternative address – Street/City/State/Zip + Extension 
8. County 
9. Phone number 
10. Miscellaneous number 
11. Mobile number  
12. Email address 
13. T-shirt Size  
14. Race (DOL) 
15. Ethnic Group (DOL) 
16. Gender (DOL) 
17. Veteran Status 
18. Member photo  
19. Birth date 
20. Change history 

Additionally, the following membership profile information is shared one way, from a respective Local to 
the Training Center: 

• Card Number 
• Local Membership Type 
• Local Membership Status 
• Paid Thru Date 
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What profile information can be updated on the Membership Portal?  

A: Only the following common demographic information can be updated on the LIUNA Chicago 
Membership Portal https://mtp.chicagolaborers.org:  

1. Title or a pre-suffix to first name  
2. First name  
3. Middle name or initial  
4. Last name 
5. Post suffix to last name  
6. Address (Primary) – Street/City/State/Zip + Extension 
7. Alternative address – Street/City/State/Zip + Extension 
8. County 
9. Phone number 
10. Miscellaneous number 
11. Mobile number  
12. Email address 
13. T-shirt Size  
14. Race (DOL) 
15. Ethnic Group (DOL) 
16. Gender (DOL) 
17. Veteran Status 

 

In MTP, what are the (DOL) selections for race, ethnic group, and gender? 

• Race (select one or more): White, Black or African American, Asian, American Indian or Alaskan 
Native, Native Hawaiian or Other Pacific Islander.  

• Ethnic Group (select one): Yes – I am Hispanic or Latino, No – I am not Hispanic or Latino.  
• Gender (select one): Male, Female, Non-binary/third gender, Prefer not to say. 

 

Are (DOL) selections for race, ethnic group, and gender required for all members? 

For apprenticeship, YES – it is a Department of Labor (DOL) requirement to report this information as 
specified. When a member changes information – at the Local or online via the Membership Portal – on 
their membership profile, NO.  

 

  

https://mtp.chicagolaborers.org/
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Can members edit their own (DOL) selections for race, ethnic group, and gender? 

Members can edit their Department of Labor (DOL) selections on the Membership Portal at any time. 
The U.S. Office of Management and Budget guidelines state DOL selections are based on self-
identification. In addition, members may choose to report more than one racial group and/or select an 
ethnic origin. 

 

What profile information is read-only on the TC’s Membership Portal and Public Directory? 

The following information, tracked and managed by the respective Local and Training Center (TC), is 
read-only on the LIUNA Chicago Membership Portal https://mtp.chicagolaborers.org and via a member’s 
Public Directory URL.  

• Training Center (TC) 
o TC Type 

 ADDED BY LOCAL – the default Type when a Local profile is synced up to the TC 
NOTE: ADDED BY LOCAL is changed to JOURNEYWORKER at the TC by a District 
Council MTP user only when proper paperwork is inserted into MTP under the 
Documents tab.  

 APPRENTICE 
 GRADUATED APPRENTICE 
 JOURNEYWORKER 

o Apprenticeship Level 
o Skills 
o Monthly Apprentice Reports 
o Class Registration 
o Contractor Hours, plus Date, Contractor Name and Number, and Local Number – 

imported from the Contribution Accounting System (CAS) 
• Local 

o LIUNA Chicago Membership Card with QR Code 
o Local Type (relative to each Local) 
o Local Status 

 ACTIVE will display as ACTIVE 
 PARTIAL PAYMENTS will display as NOT ACTIVE 
 NEW BUT NOT FULLY INITIATED will display as NOT ACTIVE 

o Paid Thru Date 

 

  

https://mtp.chicagolaborers.org/
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What does it mean if you cannot view a member’s profile on the Public Directory? 

When a member’s Public Directory URL cannot be viewed and the message “This individual is not 
active in LIUNA Chicago” is displayed, the Training Center’s Status on the member is set to something 
other than ACTIVE. 

• A list of Training Center Statuses (not Local Statues) with their Public Directory access:  
o Yes – ACTIVE 
o No – BANNED FROM THE TF 
o No – DECEASED 
o No – TERMINATED FROM APPRENTICE PROGRAM 

FYI: If a Local cannot view the Public Directory URL of a member, please contact the Training Center 
at info@liunacltaf.org (this email is sent to multiple staffers at the TC). 

 

What does the TC Membership Type ADDED BY LOCAL mean on the Public Directory? 

It is important that the Locals understand the ADDED BY LOCAL Training Center Membership Type. 

The ADDED BY LOCAL Membership Type is the TC’s default membership type when all new members 
are added by the Local in their MTP database and then synced to the Training Center. You can view a 
member’s Training Center’s Membership Type, along with other read-only field-specific information, on 
the member’s Public Directory URL. 

If your member has the TC Membership Type of ADDED BY LOCAL and you would like their TC Type to 
be changed to JOURNEYWORKER or TRAVELER, the following steps must be completed: 

• Contact District Council Kate Hughes at khughes@liunachicago.org. 
• Requested documents must be inserted under the Documents tab using the correct 

Document Sync types for the following exceptions:  
i. Experienced Employee Exception 

ii. Newly Organized Employer Exception 
iii. Transfers 
iv. Traveler for instructions 

FYI: To learn more about inserting a document under the Documents tab, see the section: When to 
Use and Insert Sync Document Types – Examples and Ownership. 

 

  

mailto:info@liunacltaf.org
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For Locals – When to add a new member to their Local MTP database 

It is important for Locals to understand who is responsible for adding a new member to MTP and what 
documents to insert into MTP under the Documents tab. 

Required documents:  

• A scanned copy of their Social Security Card needs to be inserted under the Documents tab 
using SS CARD (SYNC). 

• A scanned copy of their Driver’s License needs to be inserted under the Documents tab using 
DRIVER LICENSE (SYNC). 

A new member is defined by a unique Social Security number (SSN), which has never existed within the 
LIUNA Chicago MTP bi-directional system. Locals are responsible for adding a new member to MTP 
when they have one of the following four membership situations: 

1. Experienced Employee Exemption 
 Contractor uses the following online TC application: Contractor Apprenticeship Exemption 

Form for Experienced Employees. 
 Understand the Experienced Worker Exemption Requirements (PDF) provided by the TC that 

covers the following and more: 
• Became a member of LIUNA before January 2, 2020 (see requirements PDF above). 
• Total of # hours performed (see requirements PDF above). 
• Completed any other LIUNA apprentice program or other Building Trades apprentice 

program. 
 The Experienced Employee is added to the Local’s MTP database as a Journeyworker. 
 Submit a scanned copy of Dues Checkoff and Membership Authorization during the MTP 

Change Authorization step to add demographic information. 
 Email notifications sent to the Local from the Exemption Review Team to be inserted under 

the Documents tab using MEMBERSHIP DOCUMENTATION (SYNC). 
2. Newly Organized Employer Exemption 

 District Council approves the submitted Employee List provided by the Employer/Contractor 
during the Newly Organized Employer Exemption process. 

 The employee is added to the Local’s MTP database as a Journeyworker. 
 Submit a scanned copy of Dues Checkoff and Membership Authorization during the MTP 

Change Authorization step to add demographic information. 
 Email notifications sent to the Local from the Apprenticeship Exemption Review Team to be 

inserted under the Documents tab using MEMBERSHIP DOCUMENTATION (SYNC). 
3. Transfers  

 Local must email the District Council and the Training Center of the newly added transfer.  
 After the transfer visits the Local, they are added to the Local’s MTP database as a 

Journeyworker using their Transfer in Date. 
 Submit a scanned copy of the Dues Checkoff and Membership Authorization during the 

MTP Change Authorization step to add demographic information. 

https://www.chicagolaborers.org/apprenticeship-exemption-program/apply
https://www.chicagolaborers.org/apprenticeship-exemption-program/apply
https://www.chicagolaborers.org/content/documents/experienced_worker_exemption_requirements.pdf
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 Requested documents, as needed, to be inserted under the Documents tab using TRANSFER 
DOCUMENTATION (SYNC). 

• LIUNA Officers Site Member Status. 
• Minimum of 2400 documented and approved Contractor Hours outside District 

Council (Incoming only). 
• Transfer Card signed by both Locals (Incoming and Issued). 

4. Travelers 
 You can add a new Traveler to your Local MTP only when that member has a unique Social 

Security number (SSN) – a number that has never existed within the LIUNA Chicago MTP bi-
directional system.  

• Check if the Traveler exists within District Council by using the MTP Search At option 
and selecting the Public Directory. 

• Add New Member fields for a Traveler being added to MTP (see screenshot below) 
o Check Non Member (ensures the member is not included in Per Capita) 
o Membership Type: TRAVELER 
o Status: INACTIVE 
o Local Initiation Date: Hide 
o Check Permit SMS (default until the member unsubscribes from SMS) 

• Add demographic information by submitting a scanned copy of the Dues Checkoff 
and Membership Authorization during the MTP Change Authorization step. In the 
Member Type section, state “Traveler” and “from Local XXXX”(see screenshot 
below). 
 

 
 

    
 

• View the real-time Local Assignment indicator  
o A real-time status field based on the Local Assignment at the TC: 

 MY LOCAL (Green): The member is assigned to your Local, and 
your Local will receive working dues (see screenshot above) 
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• Save and attach an International Officer Site Membership Query result (as a Sync 
Document PDF under the Documents tab) to verify the Status and Home Local. 
 

International Officer Site Membership Query 

 
 

EXISTING TRAVELER NOTE: For existing Travelers, on the other hand, if the TRAVELER already exists at 
the Training Center, their SSN is in MTP, so you will not be able to add them to your Local MTP.  

• In the case of an existing TRAVELER, you will still have to submit a Dues Checkoff 
and Membership Authorization and wait for your next month’s close-of-business 
Local-specific CAS-to-MTP file to import into MTP. After the import, the out-of-
district Traveler’s profile, contractor, and contractor hours will be in MTP. 
 

For the Training Center – When to add a new member to the TC MTP database 

It is essential for the Local to understand who is responsible for adding a new member to MTP, 
specifically an apprentice or a permit worker. 

The Training Center (not the Local) is responsible for adding a member in the following three situations: 

1. Mandatory Apprentice 
2. Permit Worker Exception—A Permit Worker can only work up to 500 hours in a calendar year (i.e., 

Jan 1/1 through Dec 12/31). Employers will be limited to no more than one Permit Worker for 
every 10 Laborers they employ, except that employers with less than 10 Laborers can sponsor one 
Permit Worker. 

3. Peak-time Permit Worker Exception – the same rules for Permit Worker apply to a Peak Permit 
Worker except during the months of May through Sep; there is no limit of Peak Permit Workers an 
employer can have. 

FYI: A new member is defined by a unique Social Security number (SSN) – a number that has never 
existed within the LIUNA Chicago MTP bi-directional system. 
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APPRENTICE/PERMIT WORKER PROCESS:  

I. Direct the Contractor to the TC website to understand the terms of the Mandatory 
Apprentice or Permit Worker Programs: 

a. For an Apprentice, send the Contractor the following web page: Employer Referral 
to Apprentice Program. 

b. For a Permit Worker, send the Contractor the following web page: Permit Worker. 
II. Contractor then submits an apprentice/permit worker online application using one of the 

following TC application forms: 
a. Apprentice online applications: 

i. Contractor Sponsored Apprenticeship Application 
b. Permit Worker online application 

i. Contractor Sponsored Permit Worker Application 
c. Peak-time Permit Worker online application: 

i. Contractor Sponsored Peak Permit Worker Application 
III. The Apprenticeship Review Team (District Council, Training Center, and Pension & Welfare) 

receives and reviews all submitted contractor applications. Once the individual is assigned 
to a Local, the Local will receive email notifications regarding the progress of the 
apprentice/permit worker application – i.e. approved or denied. 

IV. After successful completion of the Training Center’s onboarding process, the individual is 
approved to become an apprentice/permit worker. 

V. Training Center adds the newly approved member to the TC MTP database, along with the 
required onboarding documentation and demographic information.  

VI. Training Center directs the newly approved member to make a visit to their assigned Local. 
VII. Local onboards the newly approved member by completing required local paperwork and 

educating them on union procedures and benefits. 
VIII. Local adds the approved member to their Local MTP database.    

IMPORTANT – If the above process for an apprentice/permit worker is started in reverse order – i.e. 
the Local adds the member to their MTP database first – all required TC onboarding documentation 
and demographic information will have to be added manually, which is unproductive and wastes 
time for both the TC and the Local. 

 

What are the online security measures in place for the Membership Portal? 

The following security measures are in place to keep membership profile data secure and safe: 

• Encrypted HTTPS connection on the web 
• Two-factor authentication - a secure push notification to either a mobile phone via text message 

or your email address 
• Unique password 
• Login timeout after 10 minutes of inactivity 

https://www.chicagolaborers.org/apprentice-program/employer-referral-to-apprentice-program
https://www.chicagolaborers.org/apprentice-program/employer-referral-to-apprentice-program
https://www.chicagolaborers.org/permit-worker-program/peak-apply
https://www.chicagolaborers.org/apprentice-program/apply
https://www.chicagolaborers.org/permit-worker-program/apply
https://www.chicagolaborers.org/permit-worker-program/peak-apply
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How to request and receive a reprinted LIUNA Chicago Membership Card for a member? 

There are two ways for Locals to track and receive a reprinted membership card for a member: 

1. Reprint MTP Card Flag – To request a reprint of a member’s LIUNA Chicago Membership Card, 
because of damage or loss, the Local or Training Center can check the bi-directional “Reprint 
MTP Card” flag. With this flag checked, a new membership card will be printed for the member 
in the first week of each month.  

2. Updated Headshot in MTP – When a new or updated headshot is added to a member’s profile 
in MTP, the “Reprint MTP Card” flag is automatically checked. With this flag set, a new 
membership card will be printed for the member in the first week of each month. 

Additional notes:  

Printing and Distribution – On the first Monday of every month, members that have the “Reprint 
MTP Card” flag checked will be on the list to have a new LIUNA Chicago Membership Card printed at 
the Training Center or District Council. The process of printing membership cards will happen in the 
first week of each month. Once the cards are printed, each Local will have their member’s cards 
mailed to them for distribution. 

Apprentices – It's the Training Center’s responsibility to make sure all new apprentices have a new 
membership card with a headshot photo. Apprentices usually receive their LIUNA Chicago 
Membership Card on the first day of class or within the first week of each month when the Reprint 
MTP Cards are processed, whichever comes first. 

Permit Workers – Same process as Apprentices. Permit Workers will usually receive their LIUNA 
Chicago Membership Card during their two-day permit worker training or within the first week of 
each month when the Reprint MTP Cards are processed, whichever comes first. 

Exemptions – Since it’s the Local’s responsibility to add members that are exempt or allowed to 
bypass Mandatory Apprenticeship into their MTP database, it’s also the Local’s responsibility to take 
a new headshot photo of that member so the “Reprint MTP Card” flag is automatically checked – 
see Printing and Distribution above. 
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What are the three ways a member can update their profile information? 

1. Visit Local office – Members can visit their respective local, request a membership profile 
change, and sign a required Signature Confirmation form before the update can be saved in 
MTP. For security and data sharing purposes with the Laborers’ Pension & Welfare Funds of 
Chicago and Vicinity and Fox Valley Laborers Benefit Funds, a member’s signature is required for 
all in-person profile information updates.  

NOTE: Another acceptable form with a signature is the Dues Checkoff and Authorization form 
(for new members) 

2. Over the phone with the Local – The Local office initiates the Change Authorization process 
within MTP and selects the appropriate Two-Factor Authentication option to send and receive 
the Confirmation Number to the member. Once the Confirmation Number is stated by member 
and entered in by the Local, this option becomes the digital consent for the update. 

3. Online – A member can visit the LIUNA Chicago Membership Portal login page 
https://mtp.chicagolaborers.org, log in with their credentials, review their profile information, 
and update their profile as needed. 

 

How do you track and manage an invalid address when direct mail is returned? 

Check the Invalid Address option to track when a member’s address comes back as invalid after a direct 
mail piece has been returned from the USPS.  

Now that this option is bi-directional, all LIUNA Chicago affiliates will be notified. By tracking “invalid 
addresses,” they can be removed from future direct mail campaigns to save money on postage.  

Plus, when members log into the Membership Portal, they will be notified that their address was flagged 
as “invalid.” Once their address is updated (at the Local office or via the Membership Portal), the Invalid 
Address option will automatically be turned OFF. 

 

How does MTP check a member’s Social Security number (SSN) and Paid Thru Date? 

When adding a member to MTP, a real-time database cross-check is performed on the member’s SSN to 
verify whether the number already exists in the LIUNA Chicago MTP database. 

After the member’s SSN is entered and cross-checked with the existing SSNs, the LIUNA Chicago MTP 
database will display an informational window stating the conditions under which you can add that 
member to a Local MTP database.  

The following checks will occur when adding a member into MTP: 

1. If the SSN DOES NOT exist in the LIUNA Chicago MTP database:  
a. The new member CAN be added to the Local’s MTP database. 

 

https://mtp.chicagolaborers.org/
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2. If the SSN DOES exist in the LIUNA Chicago MTP database – MTP verifies the current assigned 
Local and Paid Thru Date of the member: 

a. If the Paid Thru Date is past 12 months, 
the member CAN be added to the Local’s MTP database. 

b. If the Paid Thru Date is less than 12 months, 
the member CANNOT be added to the Local’s MTP database. 

c. If the Paid Thru Date is blank, typically in the case of a Traveler or a New Member who 
has not been initiated, the member CANNOT be added to the Local’s MTP database.  

 
For 2c (above), the Paid Thru Date is “blank”: 

 
1. Please submit a Dues Checkoff form to the District Council. 
2. Once the proper Local assignment has been determined, the District Council will 

have the correct Local assignment made to their Contribution Accounting System 
(CAS). 

3. Download and import the monthly Local-specific CAS data file into the Local’s MTP 
database.  

4. After the import, the member in question with a “blank” Paid Thru Date will 
automatically be added to the respective Local. 

 

In the Membership Portal, what are the three requirements for a new password? 

• Password must be different from the current password 
• Password must contain both letter and number characters 
• The minimum length for a password is 3 characters 

 

Will you be notified if a member updates their profile on the Membership Portal? 

A1: To see when a member has updated their profile via the Membership Portal, cross reference the 
Change History tab with the new Change Authorization tab, this will show how the member confirmed 
their identity for the update – i.e. by text or email address. 

A2: When an address, phone number or email address change has occurred on the Membership Portal, 
the “Changed Demographics” flag will be checked automatically for LIUNA International Per Captia 
Reporting. 

 

What demographic fields in MTP have formatting rules? 

On both the MTP desktop client and the Membership Portal, the following data entry fields provide 
formatting rules: 
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• Phone number fields – Phone, Mobile, and Misc. – Numerical characters only. Don’t allow for 
duplicates. Only allow for dashes. Phone numbers can be entered without spaces or dashes. 

• Address field – USPS characters only: / and # 
• City field – Alpha characters only 
• State field – Alpha characters only, in a two-letter state format 
• ZIP code field – Numerical characters only, in a five or five plus four-digit extension 
• Email address field – Only allow properly formatted email addresses with no spaces 

 

How to confirm if your Local member has the correct Local assignment at the Training Center? 

Use one of the following options below to confirm if your member has the correct Local assignment (and 
is one-to-one) at the Training Center (TC). 

• From a Local’s MTP desktop, can you click the QR code icon and view the member's Public 
Directory by selecting Open in Browser. 

o If you can view it, then the local assignment is one-to-one.  
o If you cannot view it, that member is not assigned to your Local at the TC. 

• Scan the QR code on the member's LIUNA Chicago membership card and verify the Local 
number on the member's Public Directory.  

• Execute Tools > Update from Training Center – the Local assignment field will be updated to the 
Local assignment from the TC. 

• Execute Tools > Resend Data to Training Center – if a window says you're "prohibited" from 
updating, then the member is not assigned to your Local at the TC. 

• View the real-time Local Assignment indicator  
o A real-time status field, based on Local Assignment at the TC, will visually tell you if the 

member you have loaded on your Membership Screen is assigned to your Local. The 
indicators are named: 

 MY LOCAL (Green): The member is assigned to your Local, and your Local  
will receive working dues. 

 OTHER (Red): The member is assigned to another Local and your Local  
will NOT receive working dues. 

 UNKNOWN (Yellow): This member has not been assigned to a Local at the TC 
(or DC). 

o TIP: When you have an OTHER (Red) Local Assignment indicator, use Tools > Update 
from Training Center and select Member Local to update to the Local assignment from 
the TC. See the screenshot below. 
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Guidelines, Tips and Best Practices 
 

One- and -multiple page documents to review, share, and print. 

 

Please go to the next page. 
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Procedure in MTP for Changing a Social Security Number (SSN) on a Member 
 

 

If and when a member’s SSN has been entered incorrectly, District Council must make the SSN 
correction first in Training Center’s MTP, followed by the respective Local in their MTP. Following this 
order ensures the successful profile transfer of hours earned, training class certifications, and Paid Thru 
Date from the incorrect SSN to the correct SSN. 

This is a 1 to 1 situation – one profile at the Training Center and one profile at the Local. 

REMINDER: Only the District Council, with proper documentation from the Local, has the authority to 
change a member’s SSN in the Training Center’s database. If the Local tries to correct the SSN before the 
District Council, a Shadow Profile will automatically be created (unknowingly) in the Training Center’s 
MTP. 

The steps to follow… 

• District Council calls the respective Local on the phone regarding the member. Together, they 
decide and confirm on the correct SSN for the member. 

• FIRST, District Council in MTP searches for the incorrect SSN of the member. 
• SECOND, the District Council corrects the existing SSN to new SSN in MTP. 

o Select the three-dot menu next to the SSN field. 
• THIRD, on the Local side, the Local searches in MTP for the incorrect SSN of the member. 
• FOURTH, on the Local side, the Local makes the SSN correction in MTP on that member. 

o Select the three-dot menu next to the SSN field. 
• FIFTH, on the Local side, the Local runs Tools > Resend Data to Training Center. 
• SIXTH, on the Local side, the Local runs Tools > Update from Training Center. Uncheck all 

options on the right-hand side except Member training ID number. 
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Procedure in MTP to Delete & Merge a Shadow Profile and Change the SSN 
 

 

When a Local accidentally uses/enters a wrong SSN when adding a new member in MTP, they move too 
fast and try to correct the situation locally by modifying the SSN. But when a Local makes an SSN 
correction, a Shadow Profile will automatically be created (unknowingly) in MTP at the Training Center.  

This is a 2 to 1 situation – two profiles at the Training Center and one profile at the Local. 

When a member’s SSN has been changed first on the Local side, the District Council must take the time 
to delete & merge the Shadow Profile and correct the SSN on the Training Center side. This procedure is 
important for two reasons: 1) keeps MTP clean of duplicate profiles and 2) ensures that a member’s 
profile, training & contractor history, and per capita data is linked together correctly in the LIUNA 
Chicago MTP database.  

REMINDER: For all SSN changes in MTP, the District Council must change the SSN first. If the Local makes 
the SSN correction first, before the District Council, a Shadow Profile will automatically be created 
(unknowingly) in MTP at the Training Center.  

The steps to follow... 

• District Council calls the respective Local on the phone regarding the member. Together, they 
decide what SSN is correct and which profile to delete/merge. Ideally, they want to keep the 
profile with the best MTP history (i.e., skills) or Training ID Number. 

• FIRST, District Council selects Tools > Merge and selects the correct SSN profile (to keep). Under 
the Merge delete section, they search and find the incorrect SSN profile they want to delete. 
There are two options: 

o Merge: Keep the correct SSN and delete the incorrect SSN profile 
o Reverse Merge: Keep the incorrect SSN and delete the correct SSN profile. After that is 

done, change the SSN on the existing profile (the incorrect SSN) to the correct SSN.  
• FOURTH, on the Local side, the Local searches for the member’s profile (the correct SSN) 
• FIFTH, on the Local side, the Local runs Tools > Resend Data to Training Center. 
• SIXTH, on the Local side, the Local runs Tools > Update from Training Center. Uncheck all 

options on the right-hand side except Member training ID number 

At this point, we have a 1 to 1 situation – one profile at the Training Center and one profile at the Local. 
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Procedure in MTP to Delete & Merge Two Profiles and Track SSN Change in Change History 
  

  

     OR 

 

 

These are 2 to 2 situations – two profiles at the Training Center and two profile at the Local. 

Option 1) Accidental Entry – A member will have two profiles (gray and blue) in MTP when a Local 
accidentally uses an incorrect SSN (gray) when adding a new member. Then to correct the situation, the 
Local adds another new member to MTP with the correct SSN (blue). This situation typically happens 
when there is an apprentice that already exists at the Training Center. In this situation you, documenting 
the incorrect SSN in Change History is not needed. 

Option 2) Discovery of Two Profiles – You will have one bi-directional profile with the correct SSN (blue) 
and another bi-directional profile with the incorrect SSN (gray) between the Local and the Training 
Center. To track the SSN change on the Local side, merge the correct SSN (blue) with the incorrect SSN 
(gray) and finally do an SSN Change to document the incorrect SSN changing to the correct SSN in 
Change History. 

The steps to follow... 

• District Council calls the respective Local on the phone regarding the member. Together, they 
decide on what profile to keep, what profile to delete/merge, and the following: 

o Confirm on the correct SSN for the member. 
o Confirm on the MTP Training Center ID Number to use moving forward. 
o Keep the profile that has the most up-to-date demographics and MTP history  

• FIRST, on the Local side,  
o Option 1) The Local will search and find the correct SSN profile (to keep) in MTP.  
o Option 2) The Local will search and find the incorrect SSN profile in MTP. 

• SECOND, on the Local side,  
o Option 1) Select Tools > Merge in MTP. Under the Merge delete section, search and 

find the incorrect SSN profile (to delete). 
o Option 2) Select Tools > Merge in MTP. Under the Merge delete section, search and 

find the correct SSN profile. NEXT, the Local performs an SSN Change and updates the 
incorrect SSN to the correct SSN so that the change in documented in Change History. 

 

Continue to next page 
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Now we have a 2 to 1 situation – two profiles at the Training Center and one profile at the Local. 

 

• THIRD, District Council selects Tools > Merge and selects the correct SSN profile (to keep). Under 
the Merge delete section, they search and find the incorrect SSN profile they want to delete. 
Ideally, they want to keep the profile with the best MTP history (i.e., skills) or Training ID 
Number. 

• There are two options: 
o Merge: Keep the correct SSN and delete the incorrect SSN profile 
o Reverse Merge: Keep the incorrect SSN and delete the correct SSN profile. After that is 

done, change the SSN on the existing profile (the incorrect SSN) to the correct SSN.  
• FOURTH, on the Local side, the Local searches for the member’s profile (the correct SSN) 
• FIFTH, on the Local side, the Local runs Tools > Resend Data to Training Center. 
• SIXTH, on the Local side, the Local runs Tools > Update from Training Center. Uncheck all 

options on the right-hand side except Member training ID number 

 

At this point, we have a 1 to 1 situation – one profile at the Training Center and one profile at the Local.  
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What’s the Purpose of the New LIUNA Chicago Membership Card? 
 

The following four benefits are the purpose of the new LIUNA Chicago Membership Card. However, this 
card does not replace the International Membership Card or International Card Number. 

1. View your Public Directory using your smartphone – Your new LIUNA Chicago Membership 
Card contains a square QR code with your new ID Number printed below it. Scan your QR code 
with your smartphone to view your Public Directory. Business Agents and Field Representatives 
can also scan the QR code to verify your membership profile, Local Membership Status, and Paid 
Thru Date. 
 

2. Access your membership profile – Scroll down to the bottom of your Public Directory (see #1) 
and click the Login Page tab. This will take you to Membership Portal login page 
https://mtp.chicagolaborers.org.  

a. Log in to the Membership Portal using your ID Number or International Card Number, 
which are listed on your Public Directory (see #1). 

b. Your first-time password is set to the last four digits of your Social Security number. 
After you log in, with your first-time password, you will be required to change/reset it. 

c. If you forgot your password, click Forgot Password on the login page. 
 

3. Review your profile information – Once you’re logged, click the three gray bars (in the upper 
right-hand side on a smartphone) and/or select the profile tabs to review your address, phone 
numbers, Training Center skills and class registrations, and a digital version of your membership 
card. 

a. If your membership card does not include your photo or your photo needs to be 
updated, please come into your local office or one of the training centers to have your 
photo taken and added to your profile. 

b. Please take the time to make sure your profile information is accurate and correct. 
 

4. Edit your profile information – To edit your profile, such as your address or phone number, click 
the three gray bars and select the Edit Profile tab.  

a. Before you can edit your profile, your identity needs to be verified with a confirmation 
number. 

b. Your confirmation number can be received in one of two ways: text message or email. 

Need more help? 

Learn how to log in and update your profile, in English or Spanish, by clicking the links at the bottom of 
the Membership Portal login page https://mtp.chicagolaborers.org. 

If you are having any issues with the Membership Portal, please contact the Training Center at 
info@liunacltaf.org or your local office. 

  

https://mtp.chicagolaborers.org/
https://mtp.chicagolaborers.org/
mailto:info@liunacltaf.org


 
 
 
 
 

12/3/2024  27 

How to Fix Membership Portal Login Issues? 
 

The following are steps to correct and fix when a member is having issues with logging into the 
Membership Portal. The two issues are: 

1. Can’t log in with International Card Number or ID Number and their password (first-time 
password or previous password) 

2. Member successfully used Forgot Password but still can’t log in with newly updated password 

 

In both cases above, please follow the steps below to fix the Membership Portal issue. 

1. Local searches and finds the member in the MTP desktop 
2. Local then executes Tools > Update from Training Center and checks all options to retrieve the 

member’s data from the Training Center 
3. Local calls the Training Center to reset the member’s password back the first-time password 

which is the last four digits of their Social Security number. 
a. If the Training is unavailable to reset the member’s password, follow steps #4 and #5 

and then go to #6c – click Forgot Password**. 
4. Local send the member their membership information in one of the following two ways: 

a. If the member doesn’t have a valid email address, add one. Email address is a free field 
and doesn’t require a signature; therefore the member will receive a Profile Email 
Notification  

b. If the member has a valid email address saved, send the member an email with their 
Public Directory URL via the QR code icon 

5. Local contacts the member and directs them to use the Profile Email Notification or the Public 
Directory URL to find and click the Membership Portal login page 
https://mtp.chicagolaborers.org. 

6. Once the member is on the login page, direct them to 
a. Log in to the Membership Portal using their ID Number or International Card Number, 

which are listed on their Profile Email Notification or Public Directory. 
b. Use their first-time password is set to the last four digits of your Social Security number. 

After they log in, with their first-time password, they will be required to change/reset it. 
c. If they forgot their password, have them click Forgot Password** on the login page. 

** If the member is able to change his/her password via “Forgot Password”, we know the profile 
information in MTP is correct. 

***If there are still login issues after following the step above, the only login conflict left would be: 

• Data being entered incorrectly 
• Web browser “caching” issues where data or passwords are automatically and accidentally 

being used to log into the Membership Portal.  

https://mtp.chicagolaborers.org/
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For Members – Tips on How to Use the Membership Card and Membership Portal 
 

The following tips are for members when using the new digital capabilities of the LIUNA Chicago 
Membership Card and Membership Portal. 
 

How can you view your Public Directory, on your mobile device, if 
you have your membership card? 
 

A: Scan the QR code on your membership card with your mobile 
smartphone’s camera or QR code reader app. 

 
  
How to save your Public Directory URL for easy retrieval 
 

• After you are viewing your Public Directory, save the Public 
Directory URL as a bookmark or an icon on the home page 
on your mobile device or desktop computer. 

• Use a mobile QR code reader app that tracks QR codes you 
have recently scanned. 

• Save a photo or screenshot of your membership card’s QR 
code so you can send it via text message or email. 

 
  
How can you update your profile information, such as your 
address, on the Membership Portal? 
 

1. View your Public Directory by scanning your membership 
card’s QR code. 

2. Save your Public Directory URL for easy retrieval (see the 
tips above). 

3. Once you can view your Public Directory on your mobile 
device, click the three gray bars in the upper right-hand 
corner and select Menu > Login Page. 

4. If needed, learn how to log in and update your profile, in 
English or Spanish, by clicking the links at the bottom of the 
Membership Portal login page 
https://mtp.chicagolaborers.org. 

5. Log in to the Membership Portal using your ID Number or 
International Card Number, which are listed on your Public 
Directory. 

6. Your first-time password is the last four digits of your Social 
Security number. Once you log in, with your first-time 
password, you will be required to change it. 

7. If you forgot your password, click Forgot Password on the 
login page. 

 
 

 

  

https://mtp.chicagolaborers.org/
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For Locals – Tips on How To Use the Member Card and Membership Portal 
 

The following tips & tricks are for Locals and field representatives when using the new digital 
capabilities of the LIUNA Chicago Membership Card and Membership Portal. 
 

How can you view a member’s Public Directory, on your mobile 
device, if they have their membership card? 
 

A: Scan the QR code on their membership card with your mobile 
smartphone’s camera or QR code reader app. 

 
  
If the member doesn’t have their membership card with them, 
how can you view their Public Directory on your mobile device? 
 

A: Ask your Local’s office to copy the member’s Public Directory 
link (known as a web address or URL) and send it to you via text 
message or email. The URL can be found by clicking the Public 
Directory icon in MTP desktop program. 

 
  
How can you track or manage multiple Public Directory links for 
easy retrieval? 
 

• Save the member’s Public Directory link as a bookmark on 
your mobile device or desktop computer. 

• Use a mobile QR code reader app that tracks QR codes you 
have recently scanned. 

• Ask the member to send you a photo or screenshot of their 
membership card via text message or email. 

 
  
How can you help a member update their profile information, 
such as their address, on the Membership Portal? 
 

1. Receive the member’s Public Directory link from your 
Local’s office – sent to you via text message or email. 

2. View the member’s Public Directory on your mobile device 
and click Menu > Membership Card. 

3. Have the member scan their card QR code or share their 
Public Directory link with them via text message or email. 

4. Show the member how to save their Public Directory link 
as a bookmark on their mobile device for future access. 

5. Once the member can view their Public Directory on their 
mobile device, have them click Menu > Login Page. 

6. Walk them through the “how to” guide on the Login Page. 
7. Once they’re logged in, show them how to use two-factor 

authentication to securely update their profile online. 
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Guidelines and Tips for Taking Membership Headshots at the Local or On-site 
 

Membership headshots play a very important role in the success of the LIUNA Chicago Membership 
Card and the ability to scan a member’s Public Directory QR code**. 

Membership headshots in LIUNA Chicago MTP database are bi-directional between the Training Center 
and the respective Local. Hence, if a Local or the Training Center updates a member’s headshot in MTP, 
the headshot will be updated automatically and in the Public Directory. 

On the first Monday of every month, the Training Center/District Council will print and distribute (two 
weeks later) membership cards to Locals for members whose headshots were added or updated in MTP. 

   
  LIUNA Chicago Membership Card Good Headshot Unacceptable Headshot 
   

 

  

 

Please use the following guidelines for taking an on-site photo and cropping it to be uploaded into MTP. 
These guidelines will ensure that the Membership Card (physical or digital) is a valuable communication 
tool for Business Agents, Training Center instructors, Contractors, etc. 

Headshot basics: 

1. Take indoors, if possible, and away from direct sunlight. 
2. Photograph the member in front of a solid color backdrop like a wall, or plain white or off-white 

poster board, to make the face stand out. 
3. Ask the member to remove their eyeglasses, unless they are non-tinted prescription glasses. 
4. Ask the member to take off their hat. 
5. Capture the member looking directly at the camera with their head centered, not tilted, and with a 

neutral expression or natural smile. Eye contact is important for a great headshot. If non-tinted 
prescription glasses are worn, make sure there is no reflective glare. 

6. Frame the headshot from the chest up.  
7. Ensure good lighting on the member’s face. Beware of weird shadowing. 
8. Use a digital camera or mobile smartphone with a clean and smudge-free camera lens. 
9. Use a clear image of the member’s face. Do not use filters commonly used on social media. 

 

** To scan a QR code, you need a smartphone with a camera and, in some cases, a mobile QR code reader app. FYI – iPhones 
running iOS 11 (or later) and Androids running Android 9 (or later) can scan a QR code when the camera is turned ON. 
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Guidelines and Tips for Cropping a Headshot Before Uploading to MTP 
 

The following tips & tricks steps are for Locals when they’re cropping a member’s photo into a headshot 
before it’s uploaded into MTP. 
 

1. Save the headshot photo (JPG/JPEG image file) to the 
computer’s desktop. 
 

 
 

  

2. Right-click on the photo and open the image file with a 
Windows built-in application to edit images, such as 
Photos. 

 
 

  

3. Once the image file is opened and the photo is ready to 
be edited, use the photo editing tools such as crop and 
rotate to frame the headshot in a portrait layout. 
 
TIP: On Windows 10, use a portrait aspect ratio of 10:8 

 
 

  

4. After you have cropped the photo into a portrait layout 
headshot, save the image file back to the computer’s 
desktop. 

 

  

5. Open MTP, find the member, and upload their new 
headshot  

 

  

6. After the image file is uploaded to MTP, use the Crop 
and center sizing option to adjust the headshot. 
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How to Run the Local Member Assignment at Training Center Report 
 

Follow the instructions below to learn how to run the Local Member Assignment at Training Center Report in MTP 
and verify if all your ACTIVE status members are correctly assigned to your Local at the Training Center. 

The three reasons why each Local needs to run this report monthly on your ACTIVE status Local members are to:  
1) Verify bi-directional synchronization on your members, 2) Ensure that your members are receiving MCL 
Benefits, and 3) Verify that your Local is receiving 100% of your locally-assigned work dues from District Council. 

Run the report and email the results to District Council  
 
This report will verify if all of your ACTIVE status members are 
correctly assigned to your Local at the Training Center – i.e., 
one-to-one with local assignment. 
 
REMINDER: One-to-one with local assignment in MTP for 
LIUNA Chicago determines: 
 
• MTP bi-directional synchronization 
• MCL benefits for your members 
• Working dues distribution to the correct Local 
 
How to run the report: 
 
1) Go to the MTP pop-down menu and select  

Reports > Membership Reports > Local Member 
Assignment at Training Center Report or in the Search 
menus box, in the upper right-hand corner of MTP, type 
“local assignment” and select Local Member Assignment 
at Training Center Report (Image 1). 

2) Under the Report section, check Unassigned Members 
(Image 2). 

3) Under the Membership Type to include: section, select 
Check All (Image 2). 

4) Under the Statuses to include: section, only check: ACTIVE 
(Image 2). 

5) Select Mask first 5 digits of SSN (Image 2). 
6) Click OK (Image 2). 
7) Save the PDF report to your computer. 
8) If the window, No information is available for this report 

pops up (Image 3), take and save a screenshot of the pop-
up window to your computer. 

9) Email either the PDF report (or the screenshot) to Kate 
Hughes khughes@liunachicago.org at District Council and 
David Szostak david.szostak@diamond-strategies.com. 

 
Image 1 

 

 
Image 2 

 

 
Image 3 
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Understand How To Use Sync Documents Types 
 

MTP, inside the Documents tab, can manage and share documents internally with Local staff and Sync 
Documents externally with the Training Center (TC). This capability is called “Sync Documents” and it 
allows for Locals and the TC to be more productive, save time, and go digital/paperless. 

Note that Sync Document Types are created at the Training Center. 

When inserting a document into MTP to be synced with the Training Center, select the appropriate Sync 
Document Type (see the chart below). 

Regular shared Document Types are NOT shared between a Local and the Training Center – no SYNC 
post suffix. 

 

Mapping/Associating Training Center Document Types with Local Document Types 

The 21 Sync Document Types below are also created by the TC and have been associated locally in your 
MTP Documents tab. The Sync Document Types can synchronize specific documents both ways – from 
the Local to the TC Hub and vice versa. 

When a Local creates a type in the Documents tab that is not associated with a TC type (“NONE”), the 
uploaded document will only be shared internally with your Local staff. Hence, associate the correct 
type when you need to “sync” a document in MTP. 

 

(See the next page for the Mapped/Associated Training Center Document Types Chart) 
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Mapped/Associated Training Center Document Types Chart 

Description Training Center Document Type Owner 
BIRTH DATE CHANGE (SYNC) BIRTH DATE CHANGE (SYNC) LOCAL 
DUES CHECKOFF AND MEMBERSHIP AUTHORIZATION (SYNC) DUES CHECKOFF AND MEMBERSHIP AUTHORIZATION (SYNC) LOCAL 
LOCAL CHANGE (SYNC) LOCAL CHANGE (SYNC) LOCAL 
MEMBER DOCUMENTATION (SYNC)  MEMBER DOCUMENTATION (SYNC) 

Added on Mar 12, 2023 
LOCAL 

MILITARY DOCUMENTATION (SYNC)  MILITARY DOCUMENTATION (SYNC) LOCAL 
NAME CHANGE (SYNC) NAME CHANGE (SYNC) LOCAL 
NON-LIUNA ASBESTOS SUPERVISOR CERTIFICATE (SYNC) NON-LIUNA ASBESTOS SUPERVISOR CERTIFICATE (SYNC) LOCAL 
NON-LIUNA ASBESTOS WORKER CERTIFICATE (SYNC) NON-LIUNA ASBESTOS WORKER CERTIFICATE (SYNC) LOCAL 
NON-LIUNA HAZARDOUS WASTE CERTIFICATE (SYNC) NON-LIUNA HAZARDOUS WASTE CERTIFICATE (SYNC) LOCAL 
NON-LIUNA LEAD SUPERVISOR CERTIFICATE (SYNC) NON-LIUNA LEAD SUPERVISOR CERTIFICATE (SYNC) LOCAL 
NON-LIUNA LEAD WORKER CERTIFICATE (SYNC) NON-LIUNA LEAD WORKER CERTIFICATE (SYNC) LOCAL 
RETIRED DOCUMENTATION (SYNC)  RETIRED DOCUMENTATION (SYNC) LOCAL 
SSN CHANGE (SYNC) SSN CHANGE (SYNC) LOCAL 
TRANSFER DOCUMENTATION (SYNC) TRANSFER DOCUMENTATION (SYNC) 

Add on Jul 23, 2021 
LOCAL 

APPRENTICESHIP DOCUMENTATION (SYNC) APPRENTICESHIP DOCUMENTATION (SYNC) TC 
CONTRACTOR DOCUMENTATION (SYNC) CONTRACTOR DOCUMENTATION (SYNC) 

Added on Sep 27, 2021 
TC 

EXEMPTION DOCUMENTATION (SYNC) EXCEMPTION DOCUMENTATION (SYNC) 
Added on Aug 23, 2022 

TC 

PERMIT WORKER DOCUMENTATION (SYNC) PERMIT WORKER DOCUMENTATION (SYNC) TC 
WAGE NOTICE (SYNC) WAGE NOTICE (SYNC) TC 
DRIVER LICENSE (SYNC) DRIVER LICENSE (SYNC) BOTH 
SS CARD (SYNC) SS CARD (SYNC) BOTH 

 
Note 1: The Sync Document Types above have already been created and associated to the TC document types in your MTP Documents tab. 

Note 2: See the When to Use and Insert Sync Document Types – Examples and Ownership chart below. 
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Best Practice – Standard File Name Format 

As a best practice, when a Document is inserted into MTP (Training Center or Local), please use the 
following file name format for all your Synced (and Non-Synced) documents/paperwork: 

[Last Name],<space>[First Name]<space>[TC ID Number]<space> 
[Dash Symbol]<space>[Description] 

SMITH, JOHN 7654321 – DUES CHECKOFF AND MEMBERSHIP AUTHORIZATION 

[Contractor Name]<space>[Contractor Number]<space> 
[Dash Symbol]<space>[Description] 

A-1 EXCAVATING 12345 – LETTER FROM CONTRACTOR TO LOCAL 

 

Best Practice – Name your file on the Desktop before you insert it into MTP 

1. First, scan and save the file to your Desktop 
2. Rename the file using the Standard File Name Format (see above) 
3. In MTP, under the Documents tab, insert your file 
4. Select Browse and find your file on the Desktop 
5. By using the Standard File Name Format, the Description field will automatically populate with 

the inserted file 
6. After inserting the file under the Documents tab (synced or non-synced), you can delete the file 

from your Desktop 

 

Best Practice – Save to Desktop, Name, Insert, and Delete after Inserting into MTP 

• Then, Insert it under the MTP Documents tab – MTP will automatically copy the file to your 
Default Folder. FYI: Your folder location is found in System Settings > General with “Copy” flag 
turned ON. 

 

Example Situations – Inserting Synced Document in MTP: 

• Inserted by the Local 
o New members – e.g. Dues Checkoff and Membership Authorization form 
o Exemptions  
o Local transfers documents 

• Inserted by the Training Center 
o Apprentice documents 
o Permit Worker documents 

• Inserted by the District Council 
o SSN changes 
o Merging or fixing member profiles  
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When to Use and Insert Sync Document Types – Examples and Ownership 
 

Local Use Only – Document sharing with the DC and Training Center 

 SYNC Document Types 
 

 When to Use   Example Document(s) to be Inserted (PDF) Owner 

BIRTH DATE CHANGE (SYNC)  Local Sharing with the District Council and Training Center: 
• Required by LIUNA International 
• DC has to make the change if and when a member updates 

their birth date in MTP 
  

• Birth Date Corrections from LIUNA International LOCAL 

DUES CHECKOFF AND 
MEMBERSHIP 
AUTHORIZATION (SYNC) 

 Local Sharing with the District Council: 
• New member at the Local – Apprenticeship Exemption, Permit 

Worker, Transfer In, and new Traveler 
• Reinstating (out more than a year) at the Local 
• Local change within the District Council 

  

• Dues Checkoff and Membership Authorization 
Form 

LOCAL 

LOCAL CHANGE (SYNC)  Local Sharing with the District Council:  
• Members that are out more than a year and have membership 

already in our District Council 
• LIUNA Officers’ Site documentation for the TRAVELER, 

JOURNERYWORKER, APPRENTICE, PERMIT WORKER 
  

• Dues Checkoff and Membership Authorization 
• LIUNA International Membership Status 
• CAS Contractor Hours 

LOCAL 

MEMBER  
DOCUMENTATION (SYNC) 
 
Repurposed in April 2024. 
 
Renamed from  
MCL DOCUMENTATION (SYNC) 
to  
MEMBER DOCUMENTATION 
(SYNC). 

. 
 

 Local and District Council Sharing:  
• MCL Death Benefits Form for when a member is “in good 

standing” and passes away 
• LIUNA International documentation regarding a TRAVELER or 

JOURNERYWORKER 
• LIUNA Officers’ Site documentation regarding a TRAVELER or 

JOURNERYWORKER 
• Email Notifications from the DC, TC, or a Local regarding a 

JOURNEYWORKER, PERMIT WORKER, or TRAVELER 
• Email Correspondence from DC, the TC, another Local, the 

member, a contractor, or any other entity regarding 
membership or union topics. 

• Death of Member Letter 
• Member’s Obituary 
• MCL Death Benefits Form 
• PDF of LIUNA International Membership Status 
• LIUNA International Local Assignment 
• LIUNA International Card Number 
• TC email notification of assigned apprentice 
• TC email notification of an exemption 
• TC email notification of apprenticeship 

onboarding review 
• TC email notification of permit worker 

membership type 
• Contractor email regarding a member 
• Email correspondence or email threads with 

any person/entity regarding a member 
  

LOCAL 

MILITARY 
DOCUMENTATION (SYNC) 

 Local Sharing with the District Council and Training Center: 
• Documents regarding military service 

• Military Orders – Leave, Return and/or 
Discharge 

• Email to LIUNA for Military Stipend 
• Follow-up email from LIUNA granting the 

Stipend 

LOCAL 

NAME CHANGE (SYNC)  Local Sharing with the District Council: 
• Member changes their name – legal reasons or marriage  

• Dues Checkoff and Membership Authorization 
• Change Name, Phone and Address Report 
• Name Changes Form from LIUNA International 

LOCAL 

NON-LIUNA ASBESTOS 
SUPERVISOR CERTIFICATE 
(SYNC) 

 Local Sharing with the Training Center: 
• Certification not provided by the District Council’s Training 

Center 
  

• Initial Training Certificate and/or current 
Certificate 

LOCAL 

NON-LIUNA ASBESTOS 
WORKER CERTIFICATE (SYNC) 

 Local Sharing with the Training Center: 
• Certification not provided by the District Council’s Training 

Center 
  

• Initial Training Certificate and/or current 
Certificate 

LOCAL 

NON-LIUNA HAZARDOUS 
WASTE CERTIFICATE (SYNC) 

 Local Sharing with the Training Center: 
• Certification not provided by the District Council’s Training 

Center 
  

• Initial Training Certificate and/or current 
Certificate 

LOCAL 



 
 
 
 
 

12/3/2024  37 

NON-LIUNA LEAD SUPERVISOR 
CERTIFICATE (SYNC) 

 Local Sharing with the Training Center: 
• Certification not provided by the District Council’s Training 

Center  

• Initial Training Certificate and/or current 
Certificate 

LOCAL 

NON-LIUNA LEAD WORKER 
CERTIFICATE (SYNC) 

 Local Sharing with the Training Center:  
• Certification not provided by the District Council’s Training 

Center 
  

• Initial Training Certificate and Current 
Certificate 

LOCAL 

RETIRED 
DOCMENTATION (SYNC) 

 Local Sharing with the District Council and Training Center:  
• Approved retirement information from Pension 
 

• Approved Pension Notification Letter LOCAL 

SSN CHANGE (SYNC)  Local Sharing with the District Council: 
• Member changes their Social Security number (SSN) 
 
IMPORTANT: Before you change an SSN in MTP, the Local must 
first insert SSN documentation in MTP. Second, the District 
Council must change the SSN in MTP first, then the Local. Please 
read “What is the process for a Local to change a Social Security 
number (SSN) on a member” section of the Chicago MTP Manual 
for more information.  

• Dues Checkoff and Membership Authorization 
• Declaration and Agreement of Indemnification 

Form from District Council 
• New SSN Card and Earnings Summary Sheet or 

L191 Statement 
• SSN Forward/Corrections from LIUNA 

International 

LOCAL 

TRANSFER 
DOCUMENTATION (SYNC) 

 Local Sharing with the District Council: 
• Member from a Local outside the District Council 
• LIUNA Officers’ Site documentation for transfer documentation 
• Member leaves the District Council 
• Unused (30 days) Transfer Request 

  

• LIUNA International Membership Status 
• Transfer Papers (Incoming) 
• Contractor Hours worked outside of District 

Council (Incoming only) 
• Transfer Papers (Issued) or Transfer Papers 

(Unused)  

LOCAL 

OFFICERS’ SITE 
DOCUMENTATION (SYNC) 
 
Not used as of April 2024.  
 
Use the Sync Document Type, 
MEMBERSHIP 
DOCUMENTATION (SYNC).  

 Local responsibility 
LIUNA Officers’ Site documentation for a TRAVELER, 
JOURNERWORKER, APPRENTICE, PERMIT WORKER 

• LIUNA International Membership Status 
• LIUNA International Local Assignment 
• LIUNA International Card Number 

LOCAL 
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Training Center Use Only – Document sharing with the DC and Locals  

SYNC Document Types 
 

 When to use, required and responsibilities   Example Document(s) to be Inserted (PDF) Owner 

APPRENTICESHIP 
DOCUMENTATION (SYNC) 

 Training Center Sharing with the Local: 
• All Apprentice documentation that is shared from the Training 

Center to the Locals and Contractors  

• Apprenticeship letters (PDFs): completions, 
warnings, cancelations, etc. 

TC only 

CONTRACTOR 
DOCUMENTATION (SYNC) 

 Training Center Sharing with the Local: 
• Documents received by a contractor to be shared with DC, the 

Local, and the member  

• Termination of Employment letters (PDFs) for 
an apprentice 

• Intent to Hire letters (PDFs) 
• Reschedule Requests (PDFs) 
  

TC only 

EXEMPTION  
DOCUMENTATION (SYNC) 

 Training Center Sharing with the Local: 
• Documents from the Training Center to be shared with DC, the 

Local, and the member 
 

• Exemption letters (PDFs): Mandatory 
Apprentice Program (MAP) or assessment 
results from the District Council and Training 
Center 

 

TC only 

PERMIT WORKER 
DOCUMENTATION (SYNC) 

 Training Center Sharing with the Local: 
• Permit Worker and Peak Permit Worker Review Team – Assigns 

Member to Local 
 

• Permit Worker and Peak Permit Worker 
Warning letters (PDFs) 

TC only 

WAGE NOTICE (SYNC)  Training Center Sharing with the Local: 
• Training Center emails the Wage Notice to notify the Member, 

Local, and Contractor of a wage change 
• Training Center inserts the Wage Notice in MTP for apprentice 

management and tracking and the Local 
 

• Apprentice Wage Notices (PDFs): 60%, 70%, 
80%, 90% and 100% 

• Permit Worker Wage Notice (PDFs): 100% 
 

TC only 

 

Any Entity – Document sharing for all entities  

SYNC Document Types  When to use, required and responsibilities   Example Document(s) to be Inserted (PDF) Owner 
DRIVER LICENSE (SYNC)  Training Center responsibility: 

• New Apprentice in the Mandatory Apprenticeship Program  
Local responsibility: 
• New Member at the Local – Apprenticeship Exemption, Permit 

Worker or Transfer In 

• Driver License (JPG or PDF) BOTH 

SS CARD (SYNC)  Training Center responsibility: 
• New Apprentice in the Mandatory Apprenticeship Program  

Local responsibility: 
• New Member at the Local – Apprenticeship Exemption, Permit 

Worker or Transfer In 

• SS Card (JPG or PDF) BOTH 
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Template – Letter to Members About the LIUNA Chicago Membership Card 
(Copy and paste into Word, edit as needed, print on Local Letterhead, and provide to the member) 

 

Dear [NAME OF MEMBER],  

Enclosed is your new LIUNA Chicago Membership Card with your new ID Number. If you have an old Training 
Center ID card and number, this new card replaces it. 

However, this card does not replace your International Membership Card or International Card Number. 

What can you do with your new LIUNA Chicago Membership Card? 

1. View your Public Directory – Your new LIUNA Chicago Membership Card contains a square QR code with 
your new ID Number below it. When scanning your QR code with your smartphone, you will be able to 
view your Public Directory. Business Agents and Field Representatives can also scan the QR code to review 
your profile to verify your Paid Thru Date and Local Membership Status. 
 

2. Access your membership profile – Scroll down to the bottom of your Public Directory (see #1) and click 
the Login Page tab. This will take you to Membership Portal login page https://mtp.chicagolaborers.org.  

a. Log in to the Membership Portal using your ID Number or International Card Number, which are 
listed on your Public Directory (see #1). 

b. Your first-time password is the last four digits of your Social Security number. Once you log in, 
with your first-time password, you will be required to change it. 

c. If you forgot your password, click Forgot Password on the login page. 
 

3. Review your profile information – Once you’re logged in, click the three gray bars (in the upper right-
hand side) and select the profile tabs to review your address, phone numbers, Training Center skills and 
class registrations, and a digital version of your membership card. 

a. If your membership card does not include a photo of you, please come into the [LOCAL 
NUMBER] office or one of the training centers to have your photo taken and added to your 
profile. 

b. Please take the time to make sure your profile information is accurate and correct. 
 

4. Edit your profile information – To edit your profile, such as your address or phone number, click the three 
gray bars and select the Edit Profile tab.  

a. Before you can edit your profile, your identity needs to be verified with a confirmation number. 
b. Your confirmation number can be received in one of two ways: text message or email. 

Need more help? 

Learn how to log in and update your profile, in English or Spanish, by clicking the links at the bottom of the 
Membership Portal login page https://mtp.chicagolaborers.org. 

If you are having any issues with the Membership Portal, please contact the Training Center at info@liunacltaf.org 
or the [LOCAL NUMBER] office at [PHONE NUMBER] 

 

https://mtp.chicagolaborers.org/
https://mtp.chicagolaborers.org/
mailto:info@liunacltaf.org
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Guidelines and Tips for Using Text Message (8 pages) 
 

Text Message Rollout – Copy and paste into the MTP Submit Text Messages Screen  

[First Name], this is Name. We are letting you know that XXX-XXX-XXXX is our new 
office txt msg #. We’ll use this # for local meetings, dues, and other reminders. You 
can use this # to text the office as well. 

The text message above is 192 characters (with spaces), not including the personalized mail merge [First Name] 
and the Name of the person who is sending the message from the Local. 

 

TIP 1 – Where to Find Your Text Message Number? 
You can find your permanently assigned Text Message Number 
in two locations within MTP: 

1) Help > Credits > Manage Service Credits  
(bottom of the window) 

2) The Text Inbox icon on the MTP Dashboard  
(bottom right-hand side of the screen) 

  
 

 
 

TIP 2 – Cost 
Each text message (sent via a batch from a Local’s MTP) that is 145 characters or less (including spaces) will cost 
$0.03 (1 credit).  

With the above text message, plus the personalized first names (which will vary in number of characters), each 
text message will be $0.06 (2 credits). 

 

 

TIP 3 – The Training Center or Your Local Text Message Number Never Changes 
The text message number that is permanently assigned to the Training Center or your Local never changes and is 
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connected to MTP. This means members can (and should) save those text message numbers as contacts on their 
mobile phone, so they conveniently recognize them as legitimate sources.  

TIP 4 – Members Can Send Text Messages to the Training Center or the Local 
The other benefit of a permanently assigned text message number connected to MTP is the capability for 
members (or contractors) to send their own text messages to the Training Center or Local – at no extra cost. Text 
messages that are sent to the Training Center or Local from a member will be received, flagged for notification, 
and track automatically (per individual). You can also respond to those text messages within MTP via the Text 
Inbox, so you do not have to share your personal mobile phone number and can keep it private.  

TIP 5 – One Text Message Sent per Mobile Phone Number 
Only one text message will be sent (and charged) if the same mobile phone is listed under two different profiles 
(e.g., a father and son have the same mobile phone number saved under their profiles).  

TIP 6 – Adding URLs in the Text Message 
When adding a URL (website address) to a text message you will need to add http:// or www before the website’s 
domain name. For example: http://liunachicago.org (CORRECT) or www.liunachicago.org (CORRECT). In most 
cases, using www is best because it uses the least number of characters. 

TIP 7 – How to Start a Batch Text Message? 
Here are the general steps for a simple batch text message to multiple members: 

1) Create a list of members 
a. Option A: Add them to a Label Queue manually – and do this before proceeding to Step 2 
b. Option B: Run a User Defined Report based on criteria, i.e., only ACTIVE members 

2) Go to Tools > User Define Reports…  
3) Double-click the First Name field to highlight it green, which means that it’s selected 
4) Double-click the Phone and Mobile Phone fields to highlight them green, which means they are selected. 

FYI: We are selecting both just in case a mobile phone number has been saved in the Phone field. 
5) Follow TIP 8 (see below) for change the First Name from capitalized letters to Proper Case 
6) Follow TIP 9 (see below) if you are going to use a text message a list of members from a Label Queue 
7) Then go to File > Text Message… 
8) Type or copy & paste your message in the Message field with mail merge fields for personalization,  

e.g. [First Name]: first letters must be capitalized and bookended with square brackets. 
9) Check Enable mail merge (on the bottom right-hand side of the Message field) 
10) Verify that your message and [First Name] mail merge field is correct. If not, make corrections accordingly.  
11) Check the top-level check box for the Phone and Mobile Phone columns.  

FYI: We are selecting both just in case a mobile phone number has been saved in the Phone field. 
12) Send the batch text message: 

a. Option A: Send immediately by clicking OK 
b. Option B: Schedule to send the batch text message by clicking Send at: and select a future time & 

date for the text message to be sent. Always double check your “send” time before clicking OK. 
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TIP 8 – Proper Case 
Before you send the message, set the [First Name] merge field 
to use Proper Case – View User Define Report > Options > 
Report Options > Columns (tab) – change [First Name] mail 
merge field to Proper Case in the Format pop-down. 

 
  
TIP 9 – Label Queue or User Define Report Options 
You can use the Label Queue or a User Define Report to send 
batch text messages to selected members. View User Define 
Report > Options > Report Options > Criteria (tab) – check the 
bottom-left option to use the Label Queue as source for the 
batch text message list. 

 
  
TIP 10 – Move Mobile Phone Numbers to the Correct Field 
Over time, it is best to clean up your phone number fields by 
making sure only mobile phone numbers are saved in the 
Mobile Phone field.  
 

NOTE 1: If you want to send an individual text message, use 
the Mobile Phone field icon (to the right of the phone number 
field) on the Membership Screen. See TIP 1 for the cost of an 
individual text message. 

 

NOTE 2: Use the Phone field only for saving the member’s 
LAND line at home, not their mobile phone number.  

 
 

  
TIP 11 – Automatic Pre-text in your Text Message 
The automatic pre-text "LIUNA Local 4:", as seen in the example 
is controlled on the backend of MTP and does not count as 
additional characters for your text message.  
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TIP 12 – Verify that the Text Messages were Delivered 
To verify which text messages were delivered successfully (or 
not), use the MTP tool, Utilities > Check Pending Text Message 
Batches…. Use this tool to help clean up the phone number 
fields by viewing the report results.  
 

• SENT – Successfully sent and delivered 
• ERROR: LANDLINE– A LAND line phone number such as a 

home phone number 
• ERROR – The mobile phone number no longer has a cell 

phone plan with a provider such as Verizon or AT&T 
• DO NOT TEXT – The member has requested to STOP text 

messages (i.e., the Permit SMS option is unchecked) 
• CANNOT TEXT – The phone number is not a valid, mobile 

or LAND line, or some other delivery error at that time 
 

NOTE 1: Text messages sent or received from a member (or a 
contractor) can be viewed on the Membership Screen under 
the Text Messages tab and in the Text Inbox screen. See TIP 
12 and 13.  
 
NOTE 2: On the mobile phone of the member (or contactor), 
they can also use the “Block this Caller” feature to block text 
messages via their cellular provider such as Verizon. A 
successfully SENT message will be displayed under Check 
Pending Text Message Batches… but the message has been 
blocked on their mobile phone. In this situation, you must 
contact the individual to specifically check and unblock your 
text message number on their mobile phone. 

 
 

 

  
TIP 13 – View and Track Text Messages Sent or Received from 
within the Profile’s Text Message Tab 
To view and track all the text messages sent or received from a 
member (or contractor), turn ON and display the Text Messages 
tab on your Membership Screen. All information within the tab 
is read-only. If you currently don’t have the option to display 
this tab, please contact MTP Support at (440) 439-7000 for help.  
 

NOTE: Text messages sent or received from a member (or a 
contractor) will also be displayed in Text Inbox. See TIP 13. 
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TIP 14 – View and Respond to Text Messages Sent and 
Received from Members 
The Text Inbox screen allows you to view replies and send 
responses to incoming text messages. This screen can be 
accessed from the Text Inbox icon on the MTP Desktop or 
through the menu under File > Open > Text Inbox. 
 

NOTE 1: On the top left, uncheck Show only unread 
conversations to view the history of all read (sent and 
received) text messages. 

 

NOTE 2: In the middle, at the top of the response column, the 
member’s (or contractor’s) name is hyperlinked to easily view 
and open their profile. 
 

NOTE 3: Change the Text Inbox default behavior of changing 
the message to Read automatically after it’s clicked by going 
to System Settings > Text Inbox. With this option checked 
(ON), you can now right-click on the member (left-side 
column) to either Mark as Unread or Mark as Read. 
 

NOTE 4: Text messages sent or received from a member (or a 
contractor) will also be displayed under the Text Messages 
tab. See TIP 12. 

 
 

 
Right-click to Mark as Unread 

 

 
Right-click to Mark as Read 

  
TIP 15 – Manually Turn ON/OFF the Permit SMS Option for a 
Member 
When a member has requested over the phone or through an 
email to stop receiving Training Center or Local text messages, 
can you manually turn ON/OFF the Permit SMS option. 
 

NOTE: Even with the Permit SMS unchecked, a member (or 
contactor) can send their own text messages to the Training 
Center or Local – at no extra cost. 

 

  
TIP 16 – Members Can Opt-Out with a “STOP” Text Message 
Reply 
When a member replies to the Training Center or a Local text 
message with the word, STOP, the member’s Permit SMS check 
box (on the Membership Screen) will be automatically 
“unchecked”. Hence, they will not receive future text messages. 
NO-SMS will be displayed in the Submit Text Message screen.  
 

NOTE 1: Even with the Permit SMS unchecked (OFF),  
a member can still send text messages to the Training Center 
or a Local. The messages will be tracked in the Text Inbox and 
under the member’s Text Message tab. 

 

NOTE 2: The Permit SMS can be manually checked (ON) but 
the member must submit a signed Text Message Permission 
Form to receive future text messages. See TIP 17. 
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NOTE 3: When you see a red DNT indicator in the Text Inbox 
under a sent text message to an individual, the initialism 
stands for Do Not Text. 
 
NOTE 4: On the mobile phone of the member (or contactor), 
they can also use the “Block this Caller” feature to block text 
messages via their cellular provider such as Verizon. A 
successfully SENT message will be displayed under Check 
Pending Text Message Batches… but the message has been 
blocked on their mobile phone. In this situation, you must 
contact the individual to specifically check and unblock your 
text message number on their mobile phone. 

 

  
TIP 17 – “Do Not Call” Membership Screen Check Boxes for 
Phone Fields 
When you select a Do Not Call check box option for any phone 
field on the Membership Screen, this will unselect and opt-out 
that phone field for Text Messaging or Robocall features – i.e., 
this will override the PERMIT SMS option for the specific phone 
field. OPTED-OUT will be displayed in the Submit Text Message 
screen. 

 
 

 
  
TIP 18 – How Does a Member Opt-In to Receiving Text 
Messages? 
When a member has requested to stop receiving Training 
Center or Local text messages, either by asking you directly 
(over the phone or email) or by replying to the text message 
number with the word, STOP, there is only one way to make 
them eligible again to receive individual or batch text messages. 
The member must sign a Text Message Permission Form 
printed on Local letterhead (see the next page for copy).  
 

NOTE: The Permit SMS can be manually checked (ON) but the 
member must submit a signed Text Message Permission Form 
to receive future text messages. 
 

STEPS:  
1) Ask the member to sign the Text Message Permission 

Form – See next page 
a. Scan and save the signed form as a PDF and insert it 

under the Documents tab on the member’s profile 
b. Contact MTP Support at (440) 439-7000 and email 

Support the PDF as an email attachment. Once they 
receive it, they will enable and check the Permit SMS 
option on the member’s profile. 

2) Ask the member to send a “test” text message from their 
mobile phone to your text messaging number. Verify that 
you’ve received the “test” text message in your Text 
Inbox and under the member’s Text Message tab. If not, 
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correct the mobile phone number with an over-the-phone 
Change Authorization in MTP. 

3) On the mobile phone of the member (or contactor), they 
can also use the “Block this Caller” feature to block text 
messages via their cellular provider such as Verizon. A 
successfully SENT message will be displayed under Check 
Pending Text Message Batches… but the message has 
been blocked on their mobile phone. In this situation, you 
must contact the individual to specifically check and 
unblock your text message number on their mobile 
phone. 

  
TIP 19 – How to manage Your Robocall, Text Message, and 
Emailing Credits? 
Go to Help > Credits > Manage Service Credits. In the Service 
Credits window, you will also need to add a credit card for 
reoccurring payments on robocall, text message, or emailing 
credits. 
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Template Text Message Permission Form 
(Copy and paste into Word, edit as needed, print on Local Letterhead, and provide to the member) 

 

TEXT MESSAGE PERMISSION FORM 

In the ever-changing world of technology, we always seek better, faster, and more efficient ways to connect with 
our members at LIUNA Local XXXX. As part of this technology, we want to be able to send out text messages to 
each individual. We need your written consent to send you text messages to accomplish this. 

Please fill out the information below to permit Local XXXX to send you text messages. If you do not complete this 
written permission form, we cannot send you Local XXXX communications regarding local meetings, dues, and 
other reminders. 

Name:    ___________________________________________________ 

Mobile Phone Number:  ___________________________________________________ 

 

I hereby give the LIUNA Local XXXX permission to send me text messages. 

Signature:   ___________________________________________________ 

Date:    ___________________________________________________ 

 

--- 

REMINDER: Once the above Text Message Permission Form is signed by the member: 

1. Saved the signed form as a PDF and insert it under the Documents tab on the member’s profile. 
2. Please contact MTP Support at (440) 439-7000 and email the PDF to them. Once they receive the PDF, 

they will be able to check the Permit SMS option on the member’s profile. 
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Email Template (Long Version) – How to Update Your Mailing Address 
(Copy and paste into Word, edit as needed, print on Local Letterhead, and provide to the member) 

 

Dear [NAME OF MEMBER], 

[LOCAL #] is reaching out to you to let you know that your current mailing address on file with LIUNA Chicago came 
back to us from the United States Postal Service as invalid. 

Therefore, we’d like to take this opportunity to show you how to update your mailing address online (with a 
phone, tablet, or computer).  

Please read and follow the instructions below:  

1) View your Public Directory – Your new LIUNA Chicago Membership Card contains a square QR code with your 
new ID Number below it. When you scan your QR code with your smartphone, you will be able to view your Public 
Directory. 

View your Public Directory here: https://mtp.chicagolaborers.org/MemberDirectory/[MEMBER ID NUMBER]  

2) Access your membership profile – After viewing your Public Directory (view link above), find and select the 
Login Page link. It will take you to the Membership Portal Login Page https://mtp.chicagolaborers.org.  

On the Login Page, log in to the Membership Portal using your ID Number or International Card Number, which are 
listed on your Public Directory (view link above).  

If this is your first visit to the Membership Portal Login Page, your first-time password is the last four digits of your 
Social Security number. Once you log in, with your first-time password, you will be required to change it.  

If you forgot your password, click Recover Password on the Login Page.  

3) Review your profile information – Once you’re logged into the Membership Portal, select the menu links to 
view your mailing address, phone numbers, Training Center skills, class registrations, and a digital version of your 
membership card.  

If your membership card does not include a photo of you, please visit your Local office or one of the Training 
Centers to have your photo taken and added to your profile.  

Please take the time to make sure your profile information is accurate and correct.  

4) Update your mailing address – To edit your profile on the Membership Portal, such as your address or phone 
number, click the Edit Profile link. After you’ve updated your mailing address, click Submit.  

SECURITY NOTE: Before you can update your mailing address, your identity needs to be verified with a 
confirmation number. The confirmation number can be received in one of two ways: text message or email.  

Need more help?  

Learn all about the Membership Portal, in English or Spanish, by clicking the “How to” links at the bottom of the 
Membership Portal login page https://mtp.chicagolaborers.org.  

If you are having any issues with the Membership Portal, please contact the Chicagoland Laborers’ Training Center 
at 630-653-0006.    

https://mtp.chicagolaborers.org/
https://mtp.chicagolaborers.org/
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Email Template (Short Version) – Update Your Mailing Address 
(Copy and paste into Word, edit as needed, print on Local Letterhead, and provide to the member) 

 

Dear [NAME OF MEMBER], 

[LOCAL #] is sending you this reminder to update your mailing address on file with LIUNA Chicago. 

Please read and follow the instructions below to update your mailing address online (with a phone, tablet, or 
computer): 

1) View your Public Directory 

Scan the QR code on your LIUNA Chicago Membership Card or click the link below: 

Your Public Directory: https://mtp.chicagolaborers.org/MemberDirectory/[MEMBER ID NUMBER]  

TIP – Take note of your ID Number or International Card Number because you will need it for step #2. 

2) Log into the Membership Portal 

Go to the Membership Portal Login Page https://mtp.chicagolaborers.org and log in with your ID Number or 
International Card Number. 

If you forgot your password, click Recover Password on the Login Page.  

3) Update Your Mailing Address 

Click “Edit Profile” after you are logged into the Membership Portal. 

As a security measure before you can edit your profile online, verify your identity with a confirmation number that 
is sent to you by email or text message. 

Once verified, please update your mail address as needed and click “Submit” to save your changes. 

Need more help?  

Learn more about the Membership Portal, in English or Spanish, by clicking the “How to” links at the bottom of the 
Membership Portal login page https://mtp.chicagolaborers.org.  

If you are having any issues with the Membership Portal, please contact the Chicagoland Laborers’ Training Center 
at 630-653-0006.    

https://mtp.chicagolaborers.org/
https://mtp.chicagolaborers.org/
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Computer & Server Hardware Requirements for your Local office and MTP 
 

To improve data security, here are the computer & server hardware requirements for all LIUNA Chicago affiliated 
Local offices and MTP implementations. 

 

Network Infrastructure 

• All-in-one networked printer and scanner – i.e. scan documents to PDFs 
• Microsoft Email Exchange Server  

o Microsoft 365 subscription 
o Hosted by a web provider 
o A local Microsoft Email Exchange Server 
o Cannot use free web-based email services such Gmail, Hotmail, or Yahoo 

• Backup data hardware with disaster recovery procedures 
• 20Mb symmetrical internet connection (or greater) 

 

Desktop Requirements 

• Windows 10 Professional (not Windows 10 Home) 
• 1.54GHz processor (or greater) 
• 8G RAM (or greater) 
• 256 GB hard drive 
• No less than 4 cores (preferred) 
• Ultrasharp landscape 24” or 27” monitor (dual monitors optional) 

 

Server Requirements 

• Windows Server 2019 
• SQL Express – a free entry-level database for 10 GB of data storage or less 
• 2.2GHz processor (or greater) 
• 32 GB RAM (or greater) 
• SAS drives (preferred) or minimum SSD 
• 8 cores (preferred) or minimum 4 cores  
• VMware (preferred) for virtualization when one server has both a file server and MTP 
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Best Practice for Office Productivity and Operations 
 

To improve Local office productivity and operations, here are the requirements for all LIUNA Chicago affiliated 
Local offices and MTP implementations. 

• Domain name with LIUNA – example https://www.liunalocal140.org  
o Purchase both .com and .org domains 
o Park and redirect the .com domain so that if someone types .com they will be redirected to your 

.org domain 
• Hosted website – e.g. a landing page at a minimum (and SSL for https) 
• Microsoft 365 subscription for office and team productivity 

o Organization domain emails, e.g. david.szostak@liunalocal140.org 
o Interoffice teamwork and communication 
o Interoffice calendaring 
o Secure file storage and sharing via OneDrive (internally and on mobile device) 
o Security and compliance 
o Cannot use free web-based email services such Gmail, Hotmail, or Yahoo 

• Server for MTP and member associated documents 
• Internet connection – i.e. 20Mb symmetrical connection (or greater) 
• Monthly contract with an IT support vendor 
• Backup process for data on the server – e.g. onsite or provide by INCOM 
• Online and reoccurring Local due payments option via MTP web module 
• Scan and associate all documents related to membership in MTP 
• Only use the MTP TC ID Number and stop using/saving/sharing/exporting SSNs  
• Standardize file naming convention for documents (Training Center or Local) with the MTP TC ID Number 

[Last Name],<space>[First Name]<space>[TC ID Number]<space> 
[Dash Symbol]<space>[Description] 

SMITH, JOHN 7654321 – DUES CHECKOFF AND MEMBERSHIP AUTHORIZATION 

 

 

  

https://www.liunalocal140.org/
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How to Submit and Track Your MTP Support 
 

The process and benefits of submitting and tracking your MTP Support issues/questions are as follows: 

• Unified support – your MTP issue/question will receive a unified support response by using the MTP 
Support online form. This assures that your MTP Support Request Ticket (SRT) is reviewed by everyone in 
MTP Support, not a single individual.  

• Track all your support requests – your MTP issue/question can be tracked by you and everyone at MTP 
Support by using your MTP Support Request Ticket (SRT). 

• Track any bug-related fixes – When your SRT issue/question cannot be resolved (by phone or email) 
because a bug in the software has been found and needs to be fixed, MTP Support will create a Customer 
Order Request (COR) so you can track it until it is resolved. 

 

ONLINE FORM RECOMMENDED STEPS 
 

1) Visit the MTP Support web page at https://www.membershiptrackingprogram.com/support.   

2) Complete the online MTP Support form by describing your MTP issue/question in the Issue/Question input box. 
If desired, request a specific MTP Support employee. 

3) Receive an automated Request Email from MTP Support with your MTP Support Request Ticket (SRT) for non-
bug-related tracking. Save this email, DO NOT delete it. Always reference your SRT when communicating with MTP 
Support. 

4) Reply to MTP Support using your automated Request Email by adding additional details, attachments, 
screenshots, and CC David Szostak when needed.  

5) If MTP Support contacts you by phone first regarding your SRT, continue to resolve your issue/question while on 
the phone. Remember to always reference your SRT with MTP Support.  

6) When MTP Support emails you using your automated Request Email, continue communicating through email as 
directed by MTP Support until your MTP issue/question is resolved. 

7) While communicating with MTP Support, if they cannot solve your issue/question because a bug in the software 
has been found and needs to be fixed, they will provide you with a Customer Order Request (COR) for bug-related 
tracking. 

8) If MTP Support has not contacted you by phone or email within 48 hours, use your Request Email to reply and 
ask for a status update on your SRT or COR. 

 

  

https://www.membershiptrackingprogram.com/support
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PHONE CALL RECOMMENDED STEPS 

1) Contact MTP Support by calling (440) 439-7000.  

2) Phone contact will not automatically generate a MTP Support Request Ticket (SRT).  

3) While you are on the phone with MTP Support, if they cannot resolve your issue/question, they will provide you 
with either an SRT for non-bug-related tracking or a COR for bug-related tracking as needed. 

 

RECOMMENDATIONS 

• Initiate your MTP Support requests by using the MTP Support online form (see above) because when you 
contact (phone or email) MTP Support employees directly an SRT is not automatically generated.   

• Once you have an SRT, you can track and reference it when communicating with MTP Support (phone or 
email), which is most important in my opinion.  

• And in some cases, your SRT (non-bug-related tracking) could turn into a COR bug-related tracking). Either 
way, the SRT or COR will help you track and resolve your MTP issue/question in a timely manner. 
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Member and CAS to MTP Workflow 
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Standard Membership Types 
 

See the following two pages. 



  LIU
N

A Chicago Standard M
em

bership Types 

5/10/2024 
 

 

 M
TP and CAS Types 

Abbreviations 
M

CL 
Descriptions 

50 YEAR M
EM

BER 
50 YR M

EM
BER 

Full 
50 Year M

em
ber exem

pt from
 m

onthly dues w
ho is actively w

orking at the calling. 
50 YEAR RETIREE 

50 YR RETIREE 
Retiree Benefits 

50 Year M
em

ber exem
pt from

 m
onthly dues w

ho is retired and not w
orking. 

APPREN
TICE 

APPREN
TICE 

Full 
All current Apprentices. 

CO
RPO

RATE O
FFICER 

CO
RP O

FFICER 
Full 

M
em

bers of the Fox Valley Fund w
ho are designated to the funds by their em

ployer as 
independent self-contributors. 

ISC 
ISC 

Full 
M

em
bers of the W

estchester Fund w
ho are designated to the funds by their em

ployer as 
independent self-contributors. 

JO
U

RN
EYW

O
RKER 

JO
U

RN
EYW

O
RKER 

Full 

1) All Laborers w
ith m

em
bership, assigned to a Local, and future graduated apprentices. 2) 

N
ew

 Laborers w
ith no w

ork hours prior to 2020 w
ho are new

ly organized and exem
pt from

 
m

andatory program
 as determ

ined by the JATC. 3) N
ew

 Laborers w
ith no w

ork hours prior to 
2020 w

ith w
ork history in LIU

N
A or other trades and exem

pt from
 m

andatory program
s as 

determ
ined by JATC. 

M
ATERIAL TESTER I 

M
TL TEST I 

Full 
M

em
bers w

ho w
ork as M

aterial Testers I (m
in w

age rate $10.00 below
 Journeyw

orker scale). 
M

ATERIAL TESTER II 
M

TL TEST II 
Full 

M
em

bers w
ho w

ork as M
aterial Testers II (m

in w
age rate $5.00 below

 Journeyw
orker scale). 

N
O

N
-M

EM
BER (M

TP only) 
N

O
N

-M
EM

BER 
—

 
W

orker w
ith authorization for w

ork dues assigned to Local, but not currently in active status 
w

ith Local or a "0000" w
orker w

ho w
orked prior to 2020. 

PEAK PERM
IT W

O
RKER 

PEAK PERM
IT W

O
RKER 

Full 
The sam

e rules for Perm
it W

orker apply (see below
) to a Peak Perm

it W
orker except during 

the m
onths of M

ay thru Sep, there is no lim
it of Peak Perm

it W
orkers an em

ployer can have. 

PERM
IT W

O
RKER 

PERM
IT W

O
RKER 

Full 

Perm
it W

orker can only w
ork up to 500 hours in a calendar year (Jan 1/1 thru Dec 12/31). 

M
ust be registered by every em

ployer they w
ork for and re-sponsored each year before 

w
orking in the calendar year. N

o m
ore than one Perm

it W
orker for every 10 Laborers, except 

for em
ployers w

ith less than 10 Laborers – they can sponsor one Perm
it W

orker. 
PIPELIN

E 
PIPELIN

E 
Full 

M
em

bers w
ho w

ork in pipeline and are assigned to a Local. 
RETIRED 

RETIRED 
Retiree Benefits 

Retiree w
ith retiree only M

CL benefits. 

SALARIED SU
PERVISO

R 
SALARIED SU

PR 
Full 

M
em

bers of the W
estchester Fund w

ho are designated to the funds by their em
ployer as 

salaried supervisors. 

TRAVELER 
TRAVELER 

—
 

LIU
N

A m
em

ber w
orking w

ithin CVLDC w
ho is not a m

em
ber of any affiliated CVLDC Local 

(w
ork dues only) – M

em
bership Type changes to Construction W

orker if they transfer in. 

U
N

IO
N

 REP/EM
PLO

YEE 
U

 REP/EM
PL 

Full 
M

em
bers w

ho are em
ployed w

ith LIU
N

A affiliated organizations (International, District 
Council, Local, LECET, LM

CC, Training and GRO
C). 

W
RECKIN

G
 

W
RECKIN

G
 

Full 
M

em
bers w

ho w
ork in dem

olition/w
recking, assigned to a Local, and exem

pt from
 the 

Apprenticeship Program
. M

ust rem
ain w

orking w
ith environm

ental contractors for m
inim

um
 

2,400 hours before sw
itching to any non-environm

ental contractor. 
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 M
TP and CAS Types 

Abbreviations 
M

CL 
Descriptions 

152 PU
BLIC SECTO

R 
PU

BLIC SEC-I 152  
Full 

Local 152 Lake County Forest Preserve at $25.00 per m
onth 

225 SECU
RITY 

SECU
RITY-I 225  

Full 
Local 225 Security M

em
bers at 1.30%

 
225 CLERICAL 

CLERICAL-I 225  
Full 

Local 225 H&
W

 M
em

bers at 2.00%
 

681 W
O

RKER I 
W

O
RKER-I 681 

Full 
Local 681 M

em
ber at 3.00%

 
681 W

O
RKER II 

W
O

RKER-II 681 
Full 

Local 681 M
em

ber at 2.50%
 

681 W
O

RKER III 
W

O
RKER-III 681 

Full 
Local 681 M

em
ber at 2.25%

 
681 W

O
RKER IV 

W
O

RKER-IV 681 
Full 

Local 681 M
em

ber at 1.75%
 

681 W
O

RKER V  
W

O
RKER-V 681 

Full 
Local 681 M

em
ber at 1.50%

 
681 W

O
RKER VI 

W
O

RKER-VI 681 
Full 

Local 681 M
em

ber at 1.00%
 

681 W
O

RKER VII 
W

O
RKER-VII 681 

Full 
Local 681 M

em
ber at 0.00%

 
681 PU

BLIC SECTO
R I  

PU
BLIC SEC-I 681 

Full 
Local 681 Public Sector M

em
ber at 1.75%

 
1001 PU

BLIC SECTO
R I 

PU
BLIC SEC-I 1001 

Full 
Local 1001 M

em
bers at 3.15%

 
1001 PU

BLIC SECTO
R II 

PU
BLIC SEC-II 1001 

Full 
Local 1001 M

em
bers at 3.00%

 
1001 PU

BLIC SECTO
R III 

PU
BLIC SEC-III 1001 

Full 
Local 1001 M

em
bers at 2.50%

 
1001 PU

BLIC SECTO
R IV 

PU
BLIC SEC-IV 1001 

Full 
Local 1001 M

em
bers at 1.75%

 
1092 PU

BLIC SECTO
R I 

PU
BLIC SEC-I 1092 

Full 
Local 1092 M

em
bers at 3.15%

 
1092 PU

BLIC SECTO
R II 

PU
BLIC SEC-II 1092 

Full 
Local 1092 M

em
bers at 2.00%

 
1092 PU

BLIC SECTO
R III 

PU
BLIC SEC-III 1092 

Full 
Local 1092 M

em
bers at 1.75%

 
1092 PU

BLIC SECTO
R IV 

PU
BLIC SEC-IV 1092 

Full 
Local 1092 M

em
bers at 1.00%

 
 CAS Types 

Abbreviations 
Descriptions 

FAIR SHARE 
FAIR SHARE 

A w
orker w

ho is a fair share m
em

ber w
ith private em

ployer (m
ay continue to w

ork). 

N
O

N
-CO

M
PLIAN

T 
N

O
N

-CO
M

PLIAN
T 

N
ew

ly hired w
orker w

ith no w
ork history prior to 2020 and is not in com

pliance w
ith the m

andatory apprentice 
program

. 

N
O

T-DEFIN
ED 

N
O

T-DEFIN
ED 

N
ew

 w
orker w

ith no w
ork history prior to 2020 w

hose m
em

bership type has not yet been determ
ined (for 

w
orkers w

ho CBA does not have m
andatory apprenticeship). 

JAN
U

S 
JAN

U
S 

A w
orker w

ho is a "Janus" m
em

ber w
ith public sector em

ployer (m
ay continue to w

ork). 
TERM

IN
ATED 

W
O

RKER/APPREN
TICE 

TERM
IN

ATED 
Any w

orker w
ith no w

ork history prior to 2020 w
ho w

as term
inated from

 apprenticeship/perm
it w

orker program
 

(cannot w
ork). 
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